Table of Contents

Course Scheduling Overview .................................................................................................................... 1

Database Set Up........................................................................................................................................ 2
  Logging into Scientia ................................................................................................................................. 2
  Academic Year ......................................................................................................................................... 4
  Locations & Suitabilities........................................................................................................................... 4
  Named Availability Patterns (NAP)........................................................................................................... 5
  Preferred Start Patterns ........................................................................................................................... 5
  Usage Patterns ........................................................................................................................................ 5
  Important Icons ..................................................................................................................................... 5
  Column Views & Filtering......................................................................................................................... 6
    Adding Columns ................................................................................................................................... 6
    Removing Columns ............................................................................................................................... 6
    Auto-Filter Row .................................................................................................................................. 6

Enterprise Course Planner (CP) ..................................................................................................................... 7
  Introduction & Set Up ............................................................................................................................... 7
  Modules ............................................................................................................................................... 10
    Recommended Column Layout ........................................................................................................... 11
    Creating Activity Templates ................................................................................................................ 11
  Generating Activities ............................................................................................................................. 13
    Generating Activities .......................................................................................................................... 13

Enterprise Timetabler (TT) .......................................................................................................................... 15
  Introduction & Set Up ............................................................................................................................. 15
  Activities & Resources ............................................................................................................................ 16
    Recommended Column Layout ........................................................................................................... 16
    Editing Resources ............................................................................................................................... 17
    Scheduling ....................................................................................................................................... 19
    Creating New Activities ..................................................................................................................... 22
    Creating Arranged Activities (GIS, Directed Studies, Practicums, Exchange) .................................... 23
    Creating Jointly Taught Activities ....................................................................................................... 23
    Creating Waitlists ............................................................................................................................... 27
  How to Print and Export a Timetable from Enterprise Timetabler ....................................................... 28

Last Updated: January 21, 2020
Course Scheduling Overview

This guide is organized to introduce the Scientia applications and the SISC based on their use in the UBC course scheduling process. Users can read this guide in conjunction with the training content hosted on Canvas. Users can self-enrol in the course here: https://canvas.ubc.ca/enroll/CGNHF9

This document aims to provide users with a step-by-step process while also providing information on why the recommended process should be followed and tips for efficiently and effectively using the system.

The course scheduling process involves two systems:
1) Scientia
   - Scientia is the scheduling system where activity templates are created, planned size is input, and resource requirements like, days, times, locations, and instructors, are assigned.
     - Enterprise Course Planner (CP)
     - Enterprise Timetabler (TT)
     - Reference Data Manager (RD)

2) Student Information Service Centre (SISC)
   - SISC receives a transfer of the course section information from Scientia and populates the course domain for users to complete the required registration data
     - Released seats
     - Permission to Register
     - Publish ‘Yes’ or ‘No’ to the online schedule
     - Section Type, Activity Level, Required Activities, Activity Links
     - Section Publish Notes

It is recommended that users have both Scientia and the SISC launched when doing course scheduling to make it more efficient to move between the systems.

The workflow below outlines how the systems interact:

![Workflow Diagram]

Legend:
- Yellow: Enterprise Course Planner (CP)
- Blue: Enterprise Timetabler (TT)
- Pink: SISC

The transfer to SISC can take up to 15 minutes.

Overnight Refresh - section(s) will appear in course schedule.
Database Set Up

Logging into Scientia

Scientia users are provided with a link to the Scheduling Curriculum Management Centre (SCMC) after they have been granted access. Scientia must be launched using Internet Explorer.

If you are a Mac User, contact Scheduling Services and provide your CWL as you will need to use a VDI to access Scientia. We will submit a ticket to Desktop Services to have an EduCloud account created for you.

**Why can’t I access the Scientia applications on the Scheduling and Curriculum Management Centre (SCMC)?**

Please ensure that you are using Internet Explorer when launching *Scheduling – Courses & Events*, for course scheduling.

Upon successful log in:

1) Select the correct database tab
   - The database tab will be named after the corresponding Academic Year (ex. 2019W_2020S)
   - The database you are loading will be highlighted in green:
2) Select the program you want to use:
   - Enterprise Course Planner (CP)
   - Reference Data Manager (RD)
   - Enterprise Timetabler (TT)

3) Select ‘Reload data from the server,’ as this is the quickest loading option
   - You will need to select ‘Install’ the first time you use Scientia on your computer
### Why open Course Planner (CP) and Enterprise Timetabler (TT) at log in?

You will be using both CP and TT to complete your scheduling tasks. The Scientia Portal page will time out after 5 minutes without use. By opening both at first login, you will not have to re-login to open the applications when you need to use them.

### Academic Year

- The academic year databases in Scientia are set up per academic year
  - Each academic year’s database is set up August to August and not per term
  - For example: Week 1: August 24th, 2020 and Week 53: August 23rd, 2021
- Scheduling for Winter and Summer sessions will happen in one database (ex. 2019W and 2020S)
- There are typically 53 weeks in Scientia per database. In the case that there is a leap year, the database will show 65 weeks.
- Listed below are examples of the corresponding weeks of frequently used Named Availability Patterns (NAPs):
  - Winter Term 1: Weeks 3-15
  - Winter Term 2: Weeks 20-25, 27-33
  - Winter Term All: Weeks 3-15, 20-25, 27-33
  - Summer Term 1: Weeks 38-43
  - Summer Term 2: Weeks 46-51
  - Summer Term All: Weeks 38-43, 46-51

### Locations & Suitabilities

- Locations tables will be reviewed and populated at the start of each scheduling cycle, when a new database is created.
  - Facilities Planning and Infrastructure Development will manage and update the list and the assignment of teaching space in Scientia.

### Will I be working with two databases at the same time?

For courses and events that bridge two databases, you may have to make the booking twice in order for activities and resources to be scheduled correctly.

Space booking is the primary concern to make sure a double-booking does not happen.

### Don’t see the location you are looking for?

Contact Scheduling Services via email at schedulingservices@students.ubc.ca and further investigation will be conducted.

- If there is a new room suitability, or a request to change a current suitability that would be a benefit to the scheduling process, please contact Enrolment Services. We will review the request.
How will you know what suitabilities are available for you to select?

Suitabilities will be available for you to select if it matches the day, time, room, and staff resources that have been defined.

Can new suitabilities be added to the list?
Facilities Planning manages the space inventory on campus. If you need to add new suitabilities, please email Learning Spaces via email at learning.spaces@ubc.ca and cc Scheduling Services at scheduling.services@students.ubc.ca.

Named Availability Patterns (NAP)
- Pre-defined week patterns to apply to activity templates or to individual activities
  - For example: Winter Term 1, Winter Term 2, Winter Term 1 Odd Weeks, Winter Term 1 Even Weeks
  - Named availability patterns are created and maintained by Scheduling Services
  - Users select a pattern when creating activity templates to specify the term and weeks the activities are to be scheduled for

What if there are no Named Availability Patterns (NAP) that fit what you are trying to schedule?
Users can create a custom pattern to adjust the scheduling weeks to reflect the weeks the activity must be scheduled.

Preferred Start Patterns
- Start patterns are created and maintained by Scheduling Services and are set up to match the scheduling sequence/pattern (ex. MWF starting on the hour, TR, starting every 1.5 hours).
- Preferred start patterns must be attached to each module. This will ensure all activities are scheduled for the campus preferred start pattern when the ‘Auto Schedule’ is run by Scheduling Services.

Usage Patterns
- A Usage Preference is attached to modules to ensure that, when the auto-schedule is run, all activities are scheduled based on the preferred usage.
- The Usage Preference will, almost always, be a standard preference for each campus. Prior to the auto-schedule, Scheduling Services will ensure the standard preference for each campus has been applied correctly and consistently.

Important Icons
- Writeback – The Writeback button is how you save your work to commit the changes to the database. If you do not click the Writeback icon, your changes will not be committed.
- Refresh – The Refresh button is used to view what others have saved in the system while you are working.
Column Views & Filtering

Adding Columns
To add columns, you will right-click on the header row and select ‘Column Chooser’. To add it to the header row, there are two options:
1) Select the column name and drag it to the header row
2) Double-click on the column name and it will automatically add to the header row

Removing Columns
There are two ways to remove columns:
1) Right-click on the header row, and select ‘Remove This Column’
2) Select the column and drag it into the blank area of the screen. An ‘X’ will appear as you drag. When you let go, the column will have been removed.

Auto-Filter Row
An auto-filter row will allow you to type and filter to search quickly. To add an auto-filter row, you will right-click on the header row and select ‘Show Auto Filter Row’:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Credit Provided</th>
<th>Department</th>
<th>Total Size</th>
<th>Named Availability</th>
<th>Weeks</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Module</td>
<td>0 [Select Department]</td>
<td>0 [Custom...]</td>
<td>1-52</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Enterprise Course Planner (CP)

**Introduction & Set Up**

Users will use Enterprise Course Planner (CP) to complete the following steps in the scheduling process:

- Finding and setting up available modules (ex. courses)
- Creating Activity Templates
- Generating Activities (ex. sections)

A new course will appear in Course Planner (CP) after it has been approved by Senate or a new detail version is created.

---

**Terms to Know**

**Modules**

Modules in Scientia are brought in from the Faculty Course Management (FCM) for courses and courses with detail codes that are available to be scheduled for a specific session.

Modules will appear twice in Scientia, one with a -S and one with a -W extension. The -S or -W identify which session the module should be scheduled (Winter or Summer).

Module = course code + course number + course detail code (if applicable)

**Activity Templates**

The Activity Template defines a course (module) with the Activity Type, Duration, Planned Size, and Zone. The Activity Template is set up for the purpose of creating activities (sections) at the start of the scheduling process.

**Activities**

Activities in Scientia most commonly relate to course sections in the SISC. Activities define the type of delivery, days, times, term, and location. A section can have multiple activities, so do not always assume activity = section. The section ID field in Scientia is the key field for linking activities to the same section. If you give multiple activities the same section ID, it will connect the days, times, terms for all the activities for the course schedule and registration.
Course Planner (CP) opens as a dashboard view. The three main areas users will use on the dashboard are as follows:

1) Department(s) Filter

- Use the drop-down arrow to the right of the ‘Department(s)’ filter to select your department
- Select your department by double-clicking or selecting the arrow to move it over to the ‘Selected’ department(s):
2) Modules

ECP (2019W2020S_PR001)
3) Templates

The ‘Modules’ section is where you create activity templates. To open the Module Editor, select ‘Show’ next to ‘Total’ in the ‘Modules’ section on the dashboard.

When the Module Editor opens up, you can do the following:

- Find available modules to schedule
- Add module size
- Create activity templates
Recommended Column Layout
The following columns are recommended:
- Name
- Description
- Credit Provided
- Department
- Total Size
- Named Availability Pattern
- Weeks

How can I see the full details of the module?
Users can see the full details by clicking on the module and selecting 'Form View' at the bottom of the Module Editor.

Creating Activity Templates
1) Search for the module using the auto filter row and typing in the subject in the Name column:

2) Select the module session (-S or -W) for the activity template:

3) Input the total number of students you expect to have registered across all sections of the module in the ‘Total Size’ column:
4) Select ‘Create Activity Template’:

After selecting ‘Create Activity Template’, a row will appear below:

5) Add details to the module by defining the template requirements

- **Name** – Add a forward-slash and include the activity type (ex. ‘/LEC’ for lecture, ‘/TUT’ for tutorial, etc.). This helps to easily differentiate templates created for the module.
- **Activity Type**
- **Duration** – Indicate the duration of the module. The duration can also be changed in Enterprise Timetabler (TT).
- **Planned Size** – Input the total number of students you expect to have registered per section. This number must match the total enrolment number on the SISC.
- **Existing Activities** – This number refers to the number of activities that have already been created.
- **Zone** – Select ‘UBC’ for the UBC Vancouver campus
- **Need To Generate** – This number will automatically populate after you input the planned size. The system is able to detect the number of activities to generated based off of the planned size and module size.

6) Select ‘OK’ to apply the change. If you select ‘Apply’, this will keep the Module Editor open to make additional activity templates.

**Do I need to create a new activity template for each type of activity?**

Yes, a new activity template is to be created for each different activity type. If an activity template is modified, all sections attached to the template will also be modified.
Generating Activities

The ‘Templates’ section is where you generate activities. To open the Activity Template Editor, select ‘Show’ next to ‘Total’ in the ‘Templates’ section on the dashboard:

When the Activity Template Editor opens up, you can generate your activities.

Generating Activities
1) Search for the module using the auto filter row and typing in the subject in the Name column:

2) Select the activity template that have activities to generate

3) The ‘Activities To Generate’ section will auto-populate with the same number from the ‘Need To Generate’ column:
4) Select the cog wheel icon to generate the activities:

5) Select ‘OK’ to apply the change.

6) Click the Writeback icon on the Course Planner (CP) dashboard to save the changes to the database:

How do you find/confirm the activities you have just generated? There are two options:

1) On the Course Planner (CP) dashboard in the ‘Activities’ section, click on ‘Show’ next to ‘Total’. An Activity Editor window will open, and a list of all existing activities will be displayed. Filter to find the activities you are looking for.

2) Find your generated activities for each module in Enterprise Timetabler (TT).
Enterprise Timetabler (TT)

Introduction & Set Up
Users will use Enterprise Timetabler (TT) to complete the following steps in the scheduling process:

- Viewing and modifying activities
- Assigning and editing activity resources and requirements
- Scheduling activities

The five main areas of Enterprise Timetabler (TT) are:

1) Icons & Tool Bar

![Icons & Tool Bar](image.png)

Users will be frequently using the Writeback and Refresh icons.

2) Views

![Views](image.png)

3) Activities

![Activities](image.png)
4) Status

![Status Screen]

5) Refresh

![TT Icon]

You see the Enterprise Timetabler (TT) icon on the taskbar at the bottom of the screen, but why won’t it open?

TT is opened in a minimized state. When this occurs, you will see the TT icon on the task bar; however, TT does not open on your screen. This can be fixed with the following:

1) Hover over the TT icon on the taskbar at the bottom of the screen until a grey box appears above the icon
2) Right click on the grey TT box and select Maximize
3) TT should now open on your screen

Activities & Resources

Users can customize the module screen layout to only show the data columns relevant to you.

Recommended Column Layout

The following columns are recommended:

- Name
- Module Name
- Activity Type Name
- Section ID
- Size
- Duration
- Scheduled Days
- Scheduled Start Time
- Scheduled End Time
- Allocated Location Name
- Allocated Staff Name
- Tag Names
- Scheduled
Editing Resources
After activities are generated in Course Planner (CP), users will find the created activities and define the scheduling requirements. Many of the fields required for scheduling an activity will be inherited from the module and/or created from the activity template at the time the activities are generated. The remaining fields must be completed by editing through the Activity Editor.

To edit the activities using the Activity Editor, double-click on the module in the Activity window. Fill out the following required activities:

- **Section ID** – The section ID is to be three characters. If there are letters included, they should be capitalized. If your department has consistently used certain section IDs for term 1 or term 2, we would advise that you keep it consistent. We also advise that section IDs for specific activity types remain consistent.
  - Waitlists – WL#
  - Tutorials – T#A, T#B, T#C
  - Labs – L#A, L#B, L#C
  - 99# is reserved for distance education courses

- **Availability** – After applying the change in the Activity Editor, the weeks that the course is running will be indicated with green bars

- **Planned Size** – The planned size from the activity template can be updated in the Activity Editor on Enterprise Timetabler (TT).

---

**Can I change my section ID after I have written back?**

No, once a section ID has been written back, it cannot be changed. The Activity Editor on Enterprise Timetabler (TT) will allow for the editing of the section ID but this change will not transfer properly to the SISC. If the section ID is to be changed, a new activity will need to be generated and the old activity...

---

**What happens if I uncheck the ‘Use Planned Size’ box in the Activity Editor?**

By unchecking the ‘Use Planned Size’ box in the Activity Editor, the system will not look at the room capacity and will use other requirements defined for the section.

If the planned size is not being used to search for a room, the system may also show available rooms that are lower than your intended planned size. Please ensure that the room you are selecting will work for the size of the course before scheduling.

---
Resource requirements can be defined under the ‘Resources’ tab:

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Day/Time</th>
<th>Location</th>
<th>Staff</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Monday, Wednesday, Friday</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

Select the ‘+’ icon beside each requirement to edit the respective section:

- **Day/Time** – The duration of the activity is set at the template, but a user can set more specific requirements for the days of the week the meetings must take place.

**If the course is running multiple days per week, how can I select multiple days?**

To select multiple days, hold down the ‘CTRL’ key on the keyboard before selecting the days.

- **Location** – Suitabilities work with an “AND” logic so it’s best to select less requirements in order for the system to show more available options.
  - B = Building, F = Feature, S = Subject
  - If an on-campus space is required, users must ensure that the required resource is set to ‘1’ or greater
  - If there is an off-campus or no physical location required, set the required resource to ‘0’.

- **Staff (ex. Instructors)**
  - If an instructor is required for the section, increase the staff requirement to ‘1’ or the instructor can be selected from the ‘Manual selection’.
  - If no instructor is required, such as Exchange, Work Placement, Practicum, Wait List, set the staff requirement to ‘0’.
  - If an instructor is unconfirmed, ‘TBA’, set the staff requirement to ‘0’ and complete the details when the instructor has been confirmed. ‘TBA’ should not be used.

**Can multiple instructors be attached to a course?**

Yes, to select multiple instructors, hold down the ‘CTRL’ key on the keyboard before selecting all the instructors that are to be attached to the course.
**How do I double-book a staff member?**

To allow the double-booking of staff members, please do the following in Enterprise Timetabler (TT):

1) Go to the Tools (top of page) drop-down menu and select ‘Constraints’
2) Once the Constraints box appears, under the ‘Avoid Double Booking Constraint’ category, select “Never” for Staff Member and click ‘OK’ at the bottom of the Constraints box to save
3) Writeback this change. This will allow you to double book staff members. A problem will still be triggered and the problem will need to be waived.

**Scheduling**

After the resource requirements have been defined, highlight the activity in the Activity window and right-click and select ‘Schedule’. Prior to scheduling, in the ‘Combined Timetable’ tab, you will see blue diamonds where the course can be scheduled. If a specified room is not available, the blue diamonds will not appear.

If the system scheduled you into a room that is not preferred, you can go back to the ‘Resource’ tab and select the ‘Search’ button:
Selecting the ‘Search’ button will show you a list of other available rooms that meet your resource requirements:

To select a new room, click ‘Accept’:
During Tier 1, users will only have access to view and book rooms within their Tier 1 access. When Tier 2 opens, users will be able to view and book rooms outside of their Tier 1 access.

After an activity has been scheduled, users will see the following:

- The ‘Scheduled’ column will display a check mark in the Activities window:

```
<p>| | | | | | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

- The scheduled activity(ies) will appear in the ‘Combined Timetable’ grid for the days and times scheduled:

<table>
<thead>
<tr>
<th>Activities</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
</tr>
</thead>
</table>

**Why doesn’t a room appear when I click the ‘Search’ button even though I know it’s available?**

There may be a few reasons:

1. The planned size in the Activity Editor may exceed the seat capacity of the requested room.
2. Your search setting may be limited to specific a building and/or room.
3. Your term dates and/or start and end time may be incorrect.
4. The room may be booked on one of your scheduled days. If so, you may need to remove that particular week for the activity.
5. Have you checked the room availability on the [Scientia Online Timetable]? Make sure you are checking the corresponding academic year, as each year will have new link.
Creating New Activities
If you are unable to find a suitable room for your activity, you may wish to split up your location search to see if you can find different rooms for each day the course is to run. To split up your location search, another activity will need to be generated.

1) Highlight the activity, right-click and select ‘Generate From Template’

A new line will appear for the newly generated activity. The newly generated activity will inherit all the details of the template.

2) Edit the activity in the Activity Editor with the same details as the original activity. Make sure that the same section ID and availability is given to this second activity.
3) Define the resource requirements to indicate the other day you are finding a room. Mirror the other resource requirements of the first activity.
Creating Arranged Activities (GIS, Directed Studies, Practicums, Exchange)
Some activities may have no formal meeting date and time. Arranged activities are created the same way as other activities, with the exception that they are **not scheduled**. A day, time, and location are not required. For these courses, they are to be tagged with ‘**Arranged**’. It can be tagged with ‘Arranged’ in the Activity Editor.

![Activity Editor](image)

Arranged courses do not need to be scheduled. After the course has been tagged with ‘Arranged’, the section ID and planned size indicated, select ‘OK’ to apply the changes and writeback in the system. After the course has been saved, it will sync to the SISC.

Creating Jointly Taught Activities
Jointly Taught activities are also known as cross-listed activities. Activities will be cross-listed when two or more activities meet on the same days, times, and location. Jointly taught activities should be created in an unscheduled status. All activities that are to be cross-listed should have the same defined resource requirements prior to cross-listing.

1) In the Activities window, highlight one of the activities that is to be cross-listed

2) Go ‘Actions’ and select ‘Create Jointly Taught Activity’
3) When the ‘Jointly Taught Activities’ window opens up, search for the other module(s) to be cross-listed:
4) Highlight the module that is to be cross-listed and use the arrows in the middle to connect the courses:
5) Go to the ‘Options’ tab and ensure that the ‘All’ is selected for the ‘Name’ and ‘Size’. This will combine the two activity names and the planned sizes:

![Image of activity window showing combined activity names and sizes](image)

6) Select ‘OK’ to apply the changes and select the Writeback icon to save the changes in the system.

In the Activities window, the new activity will show a combined name. Review the defined resource requirements and then schedule the cross-listed course.

![Image of Activities window showing combined activity name](image)

**Can I delete activities that are accidentally created?**

If too many activities are accidentally created, these activities can be deleted in Enterprise Timetabler (TT) by highlighting the activity in the Activity window, right-clicking, and selecting ‘Delete Activity’. Prior to deleting the activity, please contact Scheduling Services to advise them of the situation. Ensure that you are in the correct database and no students are registered in the activity. If an activity has registration and is deleted from Scientia, the section will be cancelled in the SISC and students will be immediately dropped from the course.

If all activities associated with one activity template is to be deleted, the activity template can be deleted in Course Planner (CP) in the Activity Template Editor.
Creating Waitlists
Waitlist sections can be created but will have no location defined in the resource requirements. The day, time, and staff requirements will mirror the corresponding activity.

1) Create an activity template and generate an activity for the waitlist on Course Planner (CP):

2) Fill out the planned size, section ID (ex. WL#), and other details to mirror the corresponding activity.

3) Define the resource requirements to mirror the corresponding activity. For the location, indicate that it needs no room:

4) Schedule the course with no location attached and writeback.

Do I attach the same instructor to the waitlist as the corresponding course?
If the instructor for the corresponding course is confirmed, define this in the resource requirements so students have this information. As the corresponding course will also have the instructor attached to the course at the same day and time, the double-booking constraint for staff will need to be turned off.

Does Scientia automatically register students on the waitlist when a spot opens up in the course?
No, users will need to manually register students from the waitlist when a spot opens up. To ensure that students register for the waitlist and do not jump the queue to get into the course, close registration once the course is full.
How to Print and Export a Timetable from Enterprise Timetabler

A timetable can be printed and exported from Scientia through Enterprise Timetabler (TT).

Print

1) Go to ‘File’ > ‘Print’ > ‘Current Timetable’

2) Once ‘Current Timetable’ is selected, a new window will open with a timetable:
Export

3) Go to ‘File’ > ‘Export’ > ‘Activities’, then save the file as an ‘.xls’ file
Reference Data Manager (RD)

Introduction & Set Up

Users will use Reference Data Manager (RD) to complete the following steps in the scheduling process:
- Assigning subject suitabilities to instructors to enable the successful assignment of an instructor to an activity on Enterprise Timetabler (TT)

Assigning Suitabilities to Instructors

1) Go to the ‘Resources’ section and select ‘Show’ next to ‘Staff’:

![Image of Resources section showing "Staff"]

2) A new window will open up. Search for the staff member.

![Image of staff list with search function highlighted]

3) Go to the ‘Shared With’ column and click into the box

![Image of staff list with shared with column highlighted]
4) Search for the department that is to be shared with the instructor and click on the arrow to share it with the department:

5) Select ‘OK’ to apply the changes and select the Writeback icon to save the changes in the system.

**Why is the instructor not in the Reference Data Manager (RD)?**

If an instructor is not viewable in RD, they may not have an active appointment in the HRMS. As the instructor list from RD syncs from the HRMS, T-Reps will need to follow up with their respective HR department.
SISC

Introduction & Set Up

Once a course has been scheduled or tagged with ‘Arranged’ on Enterprise Timetabler (TT), it will sync into the Student Information Service Centre (SISC) within 15 minutes.

Upon logging in:

1) Go to ‘Preferences’ at the top toolbar and select ‘Tab Settings’:

2) Double-click on ‘SISC Sections Controls’ to add it to your saved tabs. Select ‘Save Profile’ and restart your SISC and the new tab will appear.
3) After the ‘SISC Sections Control’ tab has been added, search for your course:

When the search is complete, the screen will update with your course’s information. As the section details are not complete, users will see this message:

The details for this section are not complete. Meetings of this section are not complete.

Section Type: REGU
Campus Location: UBC
Prereq Options: Ø Optional
Activity Level: Ø Required Activities:
Publish Section: Yes ☐ No ☐
Publish Meeting: Yes ☐ No ☐
Publish Room: Yes Publish All ☐ None ☐
Allow Conflicts: Yes ☐ No Override Minutes: 0 Anywhere ☐
Why isn’t my course appearing on SISC?

Please review and ensure all of the below are completed:
1) The activity has a section ID assigned to it. Section IDs must be 3 characters and any letters are capitalized.
2) Section IDs cannot be changed after the original section ID has been written back to the system. If you have modified this after, please change it back and add a new section for the new section ID.
3) Please make sure all changes have been written back.
4) It makes approximately 15 minutes from the writeback time for the data to sync from Scientia to SISC.

If you have checked all of the above, and they have been completed accordingly but you are still experiencing issues, please contact our office for assistance via email at schedulingservices@students.ubc.ca

Mandatory Fields
To complete the section details, users will need to select ‘Edit’ at the bottom of the screen and complete the following mandatory fields:
- **Term** – The term is to match the start and end date for the course.
- **Activity Level** – There are three activity level options; primary, secondary, and tertiary. The activity level selected is to match the activity type.
  - **Primary** – Generally, the main activity (ex. lecture, seminar, etc.) is a primary activity.
  - **Secondary** – If the main activity has one associated activity, the associated activity will be the secondary activity.
  - **Tertiary** – If the main activity has more than one associated activity, the third associated activity will be the tertiary activity.
- **Required Activities** – The required activities correspond with the activity levels.
  - **Primary Only** – If there is only one main activity, this is to be selected.
  - **Primary and Secondary** – If there is a main activity and one associated activity, this is to be selected.
  - **Primary, Secondary, and Tertiary** – If there is a main activity and two associated activities, this is to be selected.

After inputting the mandatory fields, review the following fields:
- **Start Date/End Date** – Confirm that these dates match the indicated availability on Enterprise Timetabler (TT)
- **Section Type**
- **Campus Location**
- **Publish Section**
- **Publish Meeting**
- **Publish Rooms**

After reviewing click ‘Save’. The following prompt will disappear after the section details are complete:

*The details for this section are not complete.  Meetings of this section are not complete.*
Why isn’t my course appearing on the online course schedule?

Please double check the following:
1) Ensure that you have completed the course section on SISC Section Controls
2) On the SISC Section Detail tab, please make sure the Publish options were selected:
   a. Publish Section: select Yes
   b. Publish Meeting: select Yes
3) Was the course added today? An overnight refresh is required before it will display on the course schedule. If the course is added after 4pm, it may take 2 overnight refreshes for it to appear.

Why can’t students register for my course?

Please double check the following:
1) You just created a section and will need to wait overnight for the Conflict Checker to run before the section is released to students.
2) The "Permit Students to Register" box under ‘SISC Sections Controls’ on SISC may not be checked.
3) The student may not meet the restrictions.
4) Section-level restrictions: Restrictions at the section level are located on the UBC Details page, under Seat Pool. You may create restrictions that are only applied to the section. When creating a restriction, do not type in any of the information for the restrictions, as this will create an error. Use the arrows or the drop-down menu. Make sure you save the seat pool and select ‘OK’ to go back to the main page.
5) Senate restrictions: Senate restrictions can be viewed on the Faculty Course Management (FCM). Senate restrictions are applied to all of the sections of the course. To remove Senate restrictions contact Senate & Curriculum Services.
6) Faculty restrictions: Also viewed on the SCMC, these restrictions are applied to all sections of a course. Students must meet these restrictions before they are able to register for the course.
7) Registration may also be prevented based on the student account (e.g., financial holds, advising required, not eligible).

Attaching Secondary and Tertiary Activities

To ensure that students are required to register for a secondary or tertiary course (ex. discussion, lab, tutorial, etc.), the associated courses are to be linked to the primary course. By linking the courses, students will be prompted to register for the associated courses when they register for the primary course.

The following steps are to be completed after the section details are completed for the primary and associated activities:
1) Search for the primary course in the SISC
2) Click ‘Edit’ and then ‘Maintain Link Sections’:

3) Select the associated section(s) to attach and click ‘Add Link’:

4) Select ‘Accept Changes’ to save: